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This product is licensed under the MPEG-4 Visual Patent Portfolio License (i) for personal and noncommercial use in connection with information 
which has been encoded in compliance with the MPEG-4 Visual Standard by a consumer engaged in a personal and noncommercial activity 
and (ii) for use in connection with MPEG-4 video provided by a licensed video provider.  No license is granted or shall be implied for any other 
use. Additional information, including that related to promotional, internal, and commercial uses, may be obtained from MPEG LA, LLC. See 
http://www.mpegla.com. 
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Export Controls
This device may contain commodities, technology or software subject to export laws and regulations from the US and other countries. Diversion 
contrary to law is prohibited.

FCC/industry Canada Notice
This device may cause TV or radio interference (for example, when using the device in close proximity to receiving equipment). The FCC or 
Industry Canada can require you to stop using your device if such interference cannot be eliminated. If you require assistance, contact your local 
service facility. This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not 
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired opera-
tion. Any changes or modifications not expressly approved by Nokia could void the user’s authority to operate this equipment.

Open Source Software Notice
This product includes certain open source or other software originated from third parties that is subject to the GNU General Public License (GPL), 
GNU Library/Lesser General Public License (LGPL) and different and/or additional copyright licenses, disclaimers and notices. The exact terms of 
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NVIDIA, CORP. MAKES NO REPRESENTATION ABOUT THE SUITABILITY OF THIS SOURCE CODE FOR ANY PURPOSE. IT IS PROVIDED “AS IS” 
WITHOUT EXPRESS OR IMPLIED WARRANTY OF ANY KIND. NVIDIA, CORP. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOURCE CODE, 
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL NVIDIA, CORP. BE
LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS 
OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOURCE CODE.

Safety
Switch On Safely 
Do not switch the device on when wireless device use is prohibited or when it may cause interfer-
ence or danger.

Interference 
All wireless devices may be susceptible to interference, which could affect performance.

Road Safety Comes First 
Obey all local laws. Always keep your hands free to operate the vehicle while driving. Your first 
consideration while driving should be road safety.

Switch Off In Hospitals 
Follow any restrictions. Switch the device off near medical equipment.

Switch Off In Aircraft 
Follow any restrictions. Wireless devices can cause interference in aircraft.

Switch Off When Refueling 
Do not use the device at a refueling point. Do not use near fuel or chemicals.

Switch Off Near Blasting 
Follow any restrictions. Do not use the device where blasting is in progress.

Use Sensibly 
Use only in the normal position as explained in the product documentation.

Qualified Service 
Only qualified personnel may repair this product.

Enhancements and Batteries 
Use only approved enhancements and batteries. Do not connect incompatible products.

Water- Resistance 
Your device is not water-resistant. Keep it dry.

Connecting To Other Devices 
When connecting to any other device, read its user guide for detailed safety instructions. Do not 
connect incompatible products.

Additional Safety Information
Small Children
Your device and its enhancements may contain small parts. Keep them out of the reach of small 
children.

Operating Environment
This device meets RF exposure guidelines when used eitherin the normal use position or when 
positioned at least1.0 centimeters (3/8 inches) away from the body. When acarry case, belt clip, or 
holder is used for body-wornoperation, it should not contain metal and should position the device 
the above-stated distance from your body. To transmit data files or messages, this device requires 
a quality connection to the network. In some cases, transmission of data files or messages may be 
delayed until such a connection is available. Ensure the above separation distance instructions are 
followed until the transmission is completed.

Parts of the device are magnetic. Metallic materials may be attracted to the device. Do not place 
credit cards or other magnetic storage media near the device, because information stored on them 
may be erased.

Battery Information
This device uses a rechargeable battery. Please refer to Pages 50-53 of this manual for Charging/
Discharging information, Battery Authentication procedure and Removal and Replacement 
information.
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Care and Maintenance
Your device is a product of superior design and craftsmanship and should be treated with care. 
The following suggestions will help you protect your warranty coverage.

  • Keep the device dry. Precipitation, humidity, and all types of liquids or moisture can contain      
     minerals that will corrode electronic circuits. If your device does get wet, remove the battery, 
     and allow the device to dry completely before replacing it.

  • Do not use or store the device in dusty, dirty areas. Its moving parts and electronic components  
     can be damaged.

  • Do not store the device in hot areas. High temperatures can shorten the life of electronic 
     devices, damage batteries, and warp or melt certain plastics.

  • Do not store the device in cold areas. When the device returns to its normal temperature, 
     moisture can form inside the device and damage electronic circuit boards.

  • Do not attempt to open the device other than as instructed in this guide.

  • Do not drop, knock, or shake the device. Rough handling can break internal circuit boards and 
     fine mechanics.

  • Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the device.

  • Do not paint the device. Paint can clog the moving parts and prevent proper operation.

  • Use a soft, clean, dry cloth to clean any lenses, such as camera, proximity sensor, and light 
     sensor lenses.

  • Use chargers indoors.

  • To reset the device from time to time for optimum performance, power off the device and 
     remove the battery.

These suggestions apply equally to your device, battery, charger, or any enhancement. If any 
device is not working properly, take it to the nearest authorized service facility for service.

Cleaning
To clean the N800’s screen, turn the unit OFF using the Power button. First use a soft dry cloth to 
remove contamination. If dirt is still present, use a damp cloth that has been squeezed of excess 
water. Use of strong chemicals and/or some cleaning agents may discolor the polyester film that 
makes up the touch screen.
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1. Introduction
The N800 4" Handheld Controller provides an intelligent, affordable solution 
for controlling audio, video, and automation equipment in a multi-room envi-
ronment or as a stand-alone controller (in a Home Theater, for example). The 
N800 4" Handheld Controller provides the freedom to control home theater 
lighting, drapes, blinds HVAC, security and more from anywhere in the home 
using a standard 802.11b/g WiFi wireless network. An ELAN SS1 System 
Station is required for two-way RS-232 feedback and control.

Touch Screen Technology
The N800 utilizes a polyester plastic film suspended over a glass panel which 
is then adhered to the front of a color LCD (Liquid Crystal Display) screen. 
Depressing the polyester film with the included stylus allows the film to touch 
the glass panel underneath, generating a location signal that is read by the 
electronics. The color LCD display is an active matrix TFT Liquid Crystal 
Display. Please use fingers or the included stylus only when operating this 
unit. Do not use pens, pencils, etc. as these may damage the polyester film.

Features

Portable Handheld Control of ELAN Systems

2- Way Feedback From Most ELAN Entertainment Sources

Easy, Powerful VIA!®TOOLS Programming

2- Way Feedback From Supported ELAN Integration Partners

High- Resolution Widescreen Display 

Web Browser With Flash Support

Zoom, Full- Screen and Panning Functions

Easy Internet Connection over Wi- Fi®

Auto Connections to Saved Wi- Fi Hot Spots

Matching VIA!® and Olé™ Skins

Built- In Stereo Speakers

Integrated Desk Stand

IR and RS- 232 Control Options With SS1 System Station

Rechargeable Internal Battery

•

•

•

•

•

•

•

•

•

•

•

•

•

•



N800 4" Handheld Controller                 E L A N  H O M E  S Y S T E M S

Page 6                        © ELAN Home Systems  2007 • All rights reserved.

N800 Quick Reference Card
The N800 is packaged with a Quick reference Card to allow users to quickly 
access all of the features of the unit. 

Figure 1.1: Quick Reference Card
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Handheld Controller Callout
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Figure 1.2: N800 Callout

Item # Item Description

1 Web Cam Not Used

2 Integrated Desk 
Stand

Allows support for tabletop use

3 Speakers Provides sound for web browsing

4 Touch Screen 4.13" LCD

5 Microphone Not used
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Hardware Keys-Front
A key press refers to the press and release of a key. Some actions depend on 
the length of the key press.

2a

1

2b

2c

2

Figure 1.3: Hardware Keys - Front

Item # Button Description

1 Scroll Key Web Browser Application:
   Moves the focus from item to another in the respective
   direction. Press the center of the scroll key to activate 
   the highlighted item, and to accept confirmation notes.
ELAN System Control:
   Top and bottom key press controls System Volume
   UP/DOWN respectively. Side to side presses control
   Channel UP/DOWN. Press the center of the scroll key
   for System MUTE.

2 Task Navigator 

   2a Escape Key Web Browser Application:
   Back
ELAN System Control:
   Access Control Panel 
   About/ELAN Devices/Settings/Installer

   2b Menu Key Web Browser Application:
   Browser Menu
ELAN System Control:
   Desktop

   2c Home Key Access VIA! Application
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Hardware Keys-Top

+-
1 2 3 4

Figure 1.4: Hardware Keys - Top

Item# Button Description

1 Zoom - Web Browser Application:
A short keypress changes the zoom level of the current 
view, and adjust the volume down in audio applications.

2 Full 
Screen

Web Browser Application:
A short keypress switches between full screen and normal 
screen modes.

3 Zoom + Web Browser Application:
A short keypress changes the zoom level of the current 
view, and adjust the volume up in audio applications.

4 Power A short keypress opens the Device Mode dialog. A long key-
press turns the N800 ON or OFF.

Side Panel
The Side Panel of the N800 features ports for connection of USB, Power and 
Headphones/Audio. There is also storage for the Stylus.

1 2 3 4

Figure 1.5: Connections - Side Panel

Item # Port/Item Description

1 Mini USB Not available for use in this application

2 Power Connector 5 VDC 890mA wall transformer connection

3 Headphone 
Connector

3.5mm Stereo mini connection

4 Stylus Removable stylus for tapping touch screen.
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2. System Design & Applications
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S8.6AV / S6 / S12
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COM2 
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SPP 
(side view) 

Sensors 
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Receivers 

SS1 
Keypads 

VIA!-SC4  or 

AUDIO SENSOR 
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Olé 
Touchpads 

Front Rear 

Triggered 
Devices 

Wireless
Touch Panel

N800

WAP Router

Figure 2.1: System Overview

The first step to a good design is to map the system. It is advisable to mark 
up a copy of the house floor plan with speaker, keypad, touch panel, touch-
pad, volume control, and equipment locations, etc. Make sure that all loca-
tions are decided upon before pre-wiring commences so that all necessary 
wiring and installation hardware is in place. This unit will be interfacing with 
other components such as relay-controlled devices, source components, 
sensors, serial controllers, and user interfaces, so it is essential that ALL sys-
tem components are accounted for prior to the pre-wire stage.

Secondly, make a detailed list of all components. Include source equipment, 
touch panels, touchpads, keypads, RS-232 controlled devices, relay con-
trolled devices, power supplies, sensors, and the SS1 System Station itself.  
Be sure to include necessary electrical boxes, structured wiring enclosures, 
telephone lines, rough-in brackets, ELAN Precision Panels, patch cables, etc.
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Pre-Wire
Pre-wiring for the SS1 System Station requires careful system planning. Pay 
close attention to where each component will be located and ensure that 
the appropriate wires are run to the correct locations! Make sure to plan for 
the future. It is often advantageous to pre-wire for components that may be 
installed later.

Wireless Access Points
Wireless Access Points (WAPs) take information originating from a wireless 
N800 Handheld Controller and send it to the system’s router. Keep in mind 
that local conditions and different WAP ranges will make each installtion dif-
ferent. Test the range before finalizing the installation locations of WAPs. Use 
Cat-5 cable to connect the WAP to the router.

Router
A Router (wired or wireless) is the heart of the N800’s communication system. 
Location of a wired router is not critical, as long as access is provided for 
connections and service. A wireless router must be located where it’s signal 
can reach the WAP and other wireless devices on the network. A router will 
typically share duties between the Handheld Controllers, ELAN VIA!dj Digital 
Music Servers, VIA!dvdj DVD Controllers, and any computers in the custom-
er’s home. Use Cat-5 cable to connect the Router to the SS1 System Station.

SS1 System Station
The SS1 System Station is an RS-232, IR, Sense and Relay controller. It also 
translates the N800’s 8.02.11b/g WiFi commands into actions that can con-
trol system functions including Home Theater or a zone control of an ELAN 
multi-room system. Future software/feature-set enhancements to the SS1  
are field-upgradeable through VIA!TOOLS setup software.
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Applications
Stand-Alone/Home Theater
The N800 Handheld Controller can be used for any Stand-Alone (non-ELAN) 
system application or as a Home Theater controller. Figure 2.1 shows a 
basic application 
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S12 Multi-Room A/V Controller
Use either ELAN's PS12 Precision Panel or SPP. Figure 2.2 shows the N800 
Handheld Controller and a PS12 or SPP connected to an ELAN S12.
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Figure 2.3: S12 Multi-Room A/V Controller Application
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S8 Multi-Room A/V Controller
ELAN's SPP (System Precision Panel) is designed to work with any S Series 
Multi-Room controller. Figure 2.3 shows the N800 Handheld Controller con-
nected to a System8 (S8.6AV or S8.6AVP) Multi-Room A/V Controller using an 
SPP. 

Note: The SPP can be used with ANY ELAN S Series Multi-Room 
Controller. Connections are identical for ELAN S6, S8 or S12 applica-
tions.

A
U

D
IO

 S
E

N
S

O
R

 

C
O

N
T
A

C
T

 S
E

N
S

O
R

 

L
E

D
/L

IG
H

T
 S

E
N

S
O

R
 

SYSTEM SS1 

ELAN    SENSE 
Sensors 

IR Controlled 
Components 

IR Outputs (x12) Sense Inputs (x6) 

1 & 2-Way 
RS-232 Controlled  

Devices (x4) 

RS-232 

HOST RS-232 

ELAN RS-232 

HOST 

ELAN 

COM 1 

COM 3 

COM 2 

COM 4 

COM1 

COM2 

COM3 

COM4 

ETHERNET 

LINK 

RX/TX 

IR-LINK 

SENSE INPUTS 

1 2 3 

4 5 6 

ALL IR OUTPUT 

EXT IR INPUT 

IR OUTPUTS 
1 

7 

2 

8 

3 

9 

4 

10 

5 

11 

6 

12 

VIA-NET 

IR 

PWR 

SS1 
POWER 
12VDC 

0.5 AMPS 
 - + 

LEXINGTON, KY • MADE IN CHINA 
MODEL: SS1 SYSTEM STATION  
 
WARNING:  DO NOT REMOVE COVER. 
NO USER SERVICEABLE PARTS INSIDE. 
REFER SERVICE TO ELAN-APPROVED 
SERVICE TECHNICIAN. 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

DC RELAY PWR RELAY 1 RELAY 2 RELAY 3 RELAY 4 RELAY 5 RELAY 6 RELAY 7 RELAY 8 

VIA!NET 

Olé 

Relay 

Gate 

Relay Controlled 
Devices (x8) 

A
U

D
IO

 S
E

N
S

O
R

 

C
O

N
T
A

C
T

 S
E

N
S

O
R

 

L
E

D
/L

IG
H

T
 S

E
N

S
O

R
 

Router 

Screen Lift Drapes 

IR Emitter 

IR Emitter 

IR Emitter 

ZONE SS1 

Wireless 
Access 
Point 

VIA!dvdj 

ELAN    SENSE 
Sensors 

® 

Relay Controlled Devices (x8) 

Home Theater 
Components 

IR Outputs (x12) Sense Inputs (x6) 

Local One-Way 
RS-232 Controlled  

Devices (x4) 

ETHERNET 
RS-232 

HOST RS-232 

ELAN RS-232 

HOST 

ELAN 

COM 1 

COM 3 

COM 2 

COM 4 

COM1 

COM2 

COM3 

COM4 

ETHERNET 

LINK 

RX/TX 

IR-LINK 

SENSE INPUTS 

1 2 3 

4 5 6 

ALL IR OUTPUT 

EXT IR INPUT 

IR OUTPUTS 
1 

7 

2 

8 

3 

9 

4 

10 

5 

11 

6 

12 

VIA-NET 

IR 

PWR 

SS1 
POWER 
12VDC 

0.5 AMPS 
 - + 

LEXINGTON, KY • MADE IN CHINA 
MODEL: SS1 SYSTEM STATION 
 
WARNING:  DO NOT REMOVE COVER. 
NO USER SERVICEABLE PARTS INSIDE. 
REFER SERVICE TO ELAN-APPROVED 
SERVICE TECHNICIAN. 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

N
C

 

C
O

M
 

N
O

 

P
W

R
 

G
N

D
 

DC RELAY PWR RELAY 1 RELAY 2 RELAY 3 RELAY 4 RELAY 5 RELAY 6 RELAY 7 RELAY 8 

Relay 

Satellite 

CD 
S8.6

VIA!NET 

Zone 1 Zone 2 Zone 3 

Zone 4 

Cat-5 

XM FM1 2 3 4 5 6 MONO

+ --

1

ZONE

1

LOCAL

2

ZONE LOCAL

3

ZONE LOCAL

4

ZONE

4

LOCAL

5

ZONE LOCAL

6

ZONE

6

LOCAL

8

LOCAL

8

ZONE

7

LOCAL

7

ZONE VIA!POWER

16VDC / 10A

16VDC / 4A

VIA!NET

TO SENSE INPUTS USE STEREO 3.5mm PLUGS ONLY EXT IR ANTENNA

PS12 

IR Emitter 

IR Emitter 

IR Emitter 

Wireless
Touch Panel

N800

Figure 2.4: S8 Multi-Room A/V Controller Application
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S6 Integrated Multi-Room Controller
Figure 2.4 shows the N800 Handheld Controller and an ELAN S6 controlling 
A/V sources, relay-controlled sources and RS-232-controlled sources.

Note: The SPP can be used with ANY ELAN S Series Multi-Room 
Controller. Connections are identical for ELAN S6, S8 or S12 applica-
tions. See Figure for details
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Figure 2.5: S6 Integrated Multi-Room Controller Application
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Z•System
Advanced features like Audio Detect and Spatial Enhancement can be 
accessed using the N800 Handheld Controller in a ELAN Z•System. Figure 
2.5 shows how to configure the N800 using a PVIA10 and ZONE SS1 for a 
Z•System application.
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Figure 2.6: Z• System Multi-Room Controller Application
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3.Connections
Power Connection
The battery recharges when connected to the included 5VDC 890mA wall 
transformer. The N800 will operate for approximately three hours of continu-
ous use on a charge; ten days in Standby mode. The charger port is located 
on the right side of the panel as shown in Figure 3.1.

Figure 3.1: Power Connection

Headphone Connection
A 3.5mm stereo connection is provided for connecting stereo headphones 
when privacy is needed. When headphones are plugged in, the built-in 
speakers are disengaged.

Figure 3.2: Headphone Connection



N800 4" Handheld Controller                 E L A N  H O M E  S Y S T E M S

Page 18                        © ELAN Home Systems  2007 • All rights reserved.

USB Port
This port is not currently used.

Figure 3.3: USB Port

System/Interface Connections
The N800 requires a VIA!SS1 System Station interface in order to function 
correctly. 

SS1 System Station
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Figure 3.4: SS1 System Station

System Types

The VIA!SS1 System Station combines functions such as IR Routing, RS-232 
control, relay activation and Ethernet control into a single device, allowing 
the N800 and other ELAN Handheld Controllers and wired VIA!s and Olé 
Touchpads to control many aspects of an A/V system and/or automation sys-
tem. The SS1 has three primary application types:

STAND- ALONE -  Connection Hub for N800 Handheld Controllers in Stand- Alone/  
      Home Theater applications.

ZONE -  Connection Hub for N800 Handheld Controllers when used as a controller   
      for a zone in an ELAN Multi- Room Controller- based system.

SYSTEM -  System Controller when connected to wired VIA! Touch Panels, Olé   
      Touchpads and ZONE SS1 Connection Hubs.

Note: Please consult the SS1 Installation Manual for complete 
details of SS1 system configuration and installation.

•

•

•
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Stand-Alone SS1
Stand-Alone applications typically use the SS1 as a Control Station/
Connection Hub for the N800 Handheld Controller. These applications can 
provide IR routing in order to control local IR sources (not part of an ELAN 
Multi-Room Controller-based system), one-way RS-232 devices that are not 
part of an ELAN Multi-Room Controller-based system, relay controlled devic-
es, and perform intelligent ON/OFF commands through the Sense Inputs. A 
Wireless Access Point is used to relay information from the N800 Handheld 
Controller to the SS1. 

Zone SS1
Zone applications consist of a wireless N800 Handheld Controller utilizing the 
SS1 as a Connection Hub when controlling a zone of an ELAN Multi-Room 
Controller-based system. ZONE applications can provide IR routing in order 
to control local IR sources, IR zone control, IR control of system-wide sourc-
es, one and two-way control of RS-232 devices, relay device control, and 
perform intelligent ON/OFF commands through the Sense Inputs. A Wireless 
Access Point is used to relay information from a N800 to the SS1. 

System SS1
System applications are used when an SS1 is performing tasks outside of 
being the control center for the N800 Handheld Controller. Often, a System 
SS1 is linked to an ELAN Multi-Room Controller-based system. These appli-
cations can control local IR sources, system-wide IR sources, ELAN Multi-
Room Controllers, one and two-way RS-232 devices, relay controlled devic-
es, and perform intelligent ON/OFF commands through the Sense Inputs.

Zone SS1s (with N800 Handheld Controllers), wireless VIA!® Touch Panels, 
wired VIA! Touch Panels, Olé™ Film Interactive Touchpads, keypads, and 
hand-held remotes can all utilize functions of a System SS1.
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SPP System Precision Panel
The SPP is designed to accomodate all connectivity required for S6, S8 and 
S12 installations, including N800s, VIA! Touch Panels and Olé Touchpads.
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Figure 3.5: SS1 SPP System Precision Panel

VIA!NET/ZNET
Use a Cat-5 wire with ELAN Standard RJ-45 pinout to connect the SS1 
System Station to a system’s VIA!NET or ZNET when installing ELAN devices 
including S6, S8, S12, and Z•630 Multi-Room Controllers and SC-4 System 
Controllers.

VIA-NET 

IR 

PWR 

Insert wires in this order:
Blue
White/Blue
Orange
White/Orange
Green
White Green
Brown
White/Brown

SS1 

BLUE             VIA Sense IN    
WHITE/BLUE        VIA IR OUT 
ORANGE               VIA NET RS-485- 
WHITE/ORANGE  VIA NET RS-485+
GREEN                  Z NET RS-485- 
WHITE/GREEN     Z NET RS-485+ 
BROWN                GND 
WHITE/BROWN    N/C 
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4 
5 
6 
7 
8 

PIN # COLOR CODE 
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T
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ELAN SS1 RJ-45 Pin-Out 

TA B 

Figure 3.6: VIA!NET/ZNET
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4. Operation/Setup
N800 Handheld Controllers are designed to be simple and intuitive to oper-
ate. Each source is custom programmed to work just the way the homeown-
er desires. ELAN recommends using the provided stylus to operate the touch 
screen. The stylus for the N800 touch screen is located in the upper right 
corner of the panel and slides out from the chassis easily

 
Figure 4.1: N800 Side View

Control Surfaces
The N800 Handheld Controller uses different display styles or “motifs”. Since 
every N800 can be designed to reflect personal preferences and the type of 
source components being utilized, button placement in the figure below may 
be different from the configuration you have designed. 

Figure 4.2: N800 Control Surface
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Device Control
The N800 can be controlled in two ways: tapping the screen with the stylus 
or pressing the hardware keys on the chassis.

Stylus
Using the stylus enables different functions depending on the context. The 
stylus can be used in the following ways (when using the Web Browser, 
Shortcuts and Settings pages):

Single Tap -  To activate controls and other interactive interface components, tap them 
once with the stylus. A single tap may open a list, activate a button in a dialog or a link on a 
web page, select a check box, and activate a text input method from a text field.

Highlight and Activate -  To highlight an item, tap it once with the stylus. To activate or 
open the item, tap it again.

Multiple Selection -  To select consecutive items, place the stylus on a non-highlighted 
item, and drag the stylus over the items. To add more items, place the stylus on a non-high-
lighted item and drag the stylus over the items. To remove a selection, tap a single item.

Drag and Drop -  To drag an item, hold the stylus down on a highlighted item, drag the 
item to its new location, and release the stylus.

Tap and Hold -  To activate a context-sensitive menu,  briefly hold the stylus down on   
an item.

Keyboard
When a text field requires input, tapping the text input field will bring up the 
keyboard to allow login passwords and other information to be entered as 
shown in Figure 4.3.

Figure 4.3: Keyboard
Text Input
To begin text input, tap any text field with the stylus or your fingers. The text 
input area appears on the touch screen and displays the keyboard 

The N800 can complete words based on the built-in dictionary for the select-
ed text input language. The N800 also learns new words from your input.

•

•

•

•

•
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On-Screen Keyboard Callout

Caps

&!é

1

3

2

9

4 65

1011

7

8

Figure 4.4: Keyboard Callout

Item Name Description

1 Tab key Adds a tabulator space or moves the cursor to the 
next available text input field.

2 Caps key Locks the uppercase characters of the keyboard. 
In the handwriting recognition mode, switches 
between the normal and special character recogni-
tion modes.

3 Shift key Allows you to enter an uppercase character in 
the On-Screen keyboard mode when you write in 
lowercase. When you tap this key in handwriting 
recognition mode, the last lowercase character 
switches to uppercase and vice versa.

4 Input Menu key Opens the Text Input Menu, which includes com-
mands such as Edit>Copy, Cut, and Paste. 

5 Space bar Inserts a space. This area also shows word com-
pletion.

6 Close key Closes the On-Screen Keyboard and Handwriting 
Recognition Input area.

7 Special Character 
key

Opens a view, in which you can select from com-
monly used special characters, symbols, and lan-
guage character accents.

8 Enter key Moves the cursor to the next row or text input 
field. Additional functions are based on the current 
context.

9 Backspace key Deletes the character to the left of the cursor.

10 Numeric 
Keyboard

When you press the shift key, the most common 
special characters are displayed in this area.

11 On-Screen Keyboard
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System Set-up
The N800 System Set-Up pages are used to enter set-up values such as 
Brightness and Volume settings, Screen Calibration, Time-Outs, and some 
additional set-up values only available to authorized installers. 

It is essential that a wireless network is in place and operating in order for 
the N800 to function.  A Wireless Acces Point (WAP) and Router (or Router/
WAP combination) must be in place and in range of the N800. See Appendix 
C: Wireless Networking for greater deatils of wireless network setup and 
equipment.

There are two areas in which settings may be adjusted:

Shortcuts

Control Panel

The Shortcuts menu appears on the main screen and is accessed by tap-
ping the icons in the upper right corner of the N800. The Control Panel is 
accessed by pressing the Escape hard control button on the left side of the 
unit while it is in ELAN mode.

Shortcuts
Located on the upper right of the touch screen Home Page are four 
Shortcut Settings icons as shown in Figure 4.5. For detailed menu struc-
tures see the following section entitled Control Panel.

Figure 4.5: Shortcuts

•

•
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Display Settings
The first icon on the left is the Display Settings, as shown in Figure 4.6. 
Tapping this selection brings up a window that allows adjustment of the 
touch screens Brightness level.

   

Figure 4.6: Display Settings

Tapping the words ‘Display Settings’ in this window opens the Display 
menu as shown in Figure 4.7. 

Figure 4.7: Display Menu
This menu includes: 

Brightness Period -  Dims the screen after a period of inactivity.

Switch Off Display -  Sets the amount of time the screen is active after use.

Lock Screen and Keys -  to keep from accidently activating the unit while being carried. 

Show LED Lights -  Turns the LED display around the navigation buttons On or Off. 

After setting up this page select the OK button to save the changes and 
return to the ELAN (Main) page. 

•

•

•

•
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Sound Settings
Second from the left is the Sounds icon that, when tapped, brings up the 
controls for the Master Volume of the N800.

   

Figure 4.8: Sound Settings

Tapping the word Sound Settings in this window will display the Sounds 
menu which has two tabs. First is the General tab which contains the 
Master Volume control with a ramping +/- indicator bar. It also has two 
levels of sound available for the System Sounds, Key Sounds, and Touch 
Screen sounds. The second tab is for Ringtones (not applicable). After set-
ting the levels select Close to return to the Home Page.

Figure 4.9: Sounds - General Tab
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Network Connectivity
The third Shortcut Icon from the left is Network Connectivity as shown in 
Figure 4.10. Tapping this icon brings up a window that allows the panel to 
disconnect and change network connections.

      

Figure 4.10: Network Connectivity

Figure 4.11: Change Connection Menu

Select Disconnect and a pop-up window will ask if you wish to disconnect. 
Click OK to disconnect or Cancel to exit. The Change Connection menu 
will search for nearby networks and display them for selection indicating 
signal strength and encryption status. Highlight the network you wish to con-
nect to and click on Connect.



N800 4" Handheld Controller                 E L A N  H O M E  S Y S T E M S

Page 28                        © ELAN Home Systems  2007 • All rights reserved.

Battery Level Indicator
The fourth icon is the Battery Level Indicator. Tapping this icon will bring 
up a pop-up window that gives estimated battery time when in Idle mode 
and when in use. Tap on the ELAN page to navigate away from this window. 
Select the Home navigation button to return to the VIA! Control screen.

    
Figure 4.12: Battery Level Indicator

Control Panel
About
While in ELAN mode (showing the system control screen), select the Escape 
navigation button to enter the Control Panel. Menu buttons line the right 
side of the screen vertically, the top button selects the About page.

Figure 4.13: Control Panel - About

Tapping the About button brings up the device Software Version, the 
Project Name, the Zone Name, the Zone Number, and Motif type as shown in 
Figure 4.13.
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ELAN Devices
Tapping the ELAN Devices button brings up the device Name, Type, and IP 
Address.

Figure 4.14: Control Panel - ELAN Devices
Settings
The Settings button brings up the Settings page. The following choices 
are available: Screen Calibration, Date and Time, Display, Connectivity, 
Language and Region, and Sounds. Several of these choices duplicate 
functions found on the Shortcuts area described previously.

Figure 4.15: Control Panel - Settings
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Screen Calibration
If at any time the touch screen responds inaccurately, you may need to cali-
brate it. Select Screen Calibration from the Settings page. If the touch 
screen does not respond at all, you can also access this function by pressing 
Menu in the Home View and using the Scroll key to navigate withinin the 
menu.

The calibration sequence consists of touching and holding the screen in four 
different places. Use the stylus and tap where indicated on the touch-screen 
in accordance with the displayed instructions as shown in Figure 4.16.

Figure 4.16: Control Panel - Screen Calibration

Date and Time
Select Date and Time to open the window for this function. Home City, 
Date, Time as well as Daylight Saving Zone can be set. Press OK to save the 
information.

Figure 4.17: Control Panel - Date and Time
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Figure 4.18: Date and Time - Date

Figure 4.19: Date and Time - Time

Figure 4.20: Date and Time - Daylight Savings Time
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Display
The Display menu allows fine-tuning of the functions Brightness, 
Brightness Period, Switch Off Display (timeout), Lock Screen and Keys 
and Show LED Lights.

Figure 4.21: Control Panel - Display

Select Display to change the display settings. The Brightness setting is 
automtically selected first. Use this to adjust the brightness of the display 
using the +/- increment buttons.

Figure 4.22: Display - Brightness
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Use Brightness Period to define how soon the display brightness decreases 
in order to save power. Switch Off Display determines the time out period 
that the the display is illuminated after the last touch. Choose between 10 
seconds, 30 seconds, 1 minute, 2 minutes and 5 minutes.

Figure 4.23: Display - Brightness Period/Switch Off Display

Lock Screen and Keys sets the automatic lock for the touch screen and 
keys. 

Figure 4.24: Display - Lock Screen and Keys



N800 4" Handheld Controller                 E L A N  H O M E  S Y S T E M S

Page 34                        © ELAN Home Systems  2007 • All rights reserved.

Show LED Lights turns On or Off the Blue LED’s around the ‘hard’ naviga-
tion buttons on the front of the device. Press OK to save the settings.

Figure 4.25: Display - Show LED Lights

Connectivity
Select Connectivity to edit and create Internet connections and to adjust 
creation logic. This window contains two selections: General and Idle 
Times. See Appendix C: Wireless Networking for greater deatils of wire-
less network setup and equipment.

Figure 4.26: Control Panel - Connectivity
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General
The general tab contains the options: Connect automatically and Search 
interval. These options determine how the N800 connects to the home net-
work in order to function with ELAN’s SS1 System Station and the Internet.

Connect Automically

Select WLAN Connections.

Figure 4.27: Connectivity - Connect Automatically

Select Connection. Connections that have been saved in the network   
     Connectivity steps will be displayed.

Figure 4.28: Connectivity - Connections

Select the connection established for the ELAN system, then select Done.  
      For the most reliable connectivity, place only the ELAN network in this area.

Once the connection is selected, click OK.

•

•

•

•
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Connection Setup
To Setup or Edit connections: 

Select the connection to be edited

Select WLAN, then Network Name (name of WAP), Network Mode (infra  
     structure), then Security Method (None, WEP, WPA Pre-Shared key,   
      WPA with EAP). These settings will vary depending on the structure of the   
      network.

Fill in appropriate information based on the network configuration.

Figure 4.29: Connectivity - Setup/Edit Connections

Figure 4.30: Connectivity - Security Method

•

•

•
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Figure 4.31: Connectivity - WEP Key

Advanced
To set Advanced functions:

Select Advanced button

Proxies -  not typically used

IP Address -  Set N800 to static IP address (not recommended)

Other -  Transmission Power -  100mw (default) provides best range  
      10mw saves power but reduces range

Select OK

Select Finish 

Figure 4.32: Connectivity - Advanced Settings

•

•

•

•

•

•
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Figure 4.33: Connectivity - Advanced Settings

To set a static IP address, Select the IP Addreses Tab, uncheck the Auto-
Retrieve IP Address box, then fill in the appropriate information.

Figure 4.34: Advanced Settings - IP Addresses

Search Interval- Define how often connections are searched in the back-
ground.

Figure 4.35: Advanced Settings - Search Interval
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NOTE: Once you have saved one or more WLAN(s) in Connections, 
the N800 searches for those connections every 10 minutes by 
default, while there is no ongoing connection. To disable the search 
in the background (in order to save battery power), set the search 
interval value to Never.

On the Idle Times page, select the time after which the Internet connection 
ends automatically if the connection is not used. Use WLAN Idle Time for 
connections created through a WLAN access point.

Figure 4.36: Advanced Settings - Idle Time

NOTE: The network may also have idle timers that may cause the 
internet connection to break, regardless of the idle timers of the 
N800.

When an application is accessed that requires an Internet connection, the 
N800 uses the WLAN connections you have saved by default. If connections 
have not been saved or they are unavailable, you are asked to select the 
Internet Access Point to use. You can save the network after selecting it from 
the list. However, if the WLAN network name is set as hidden, the settings 
must be configured manually.
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Language and Region
Tapping this button selects the Region and Device Language.

Figure 4.36: Control Panel - Language and Region

Figure 4.37: Control Panel - Device Language

Sounds
The Sounds menu is identical to what is described in the Shortcuts section. 
See Shortcuts for details.
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Installer
Tapping the Installer button brings up the Password screen, shown in 
Figure 4.38.

Figure 4.38: Installer - Password

Enter the Password: 9195. Then press OK.

The Download screen will then be displayed as shown in Figure 4.39. 

Figure 4.39: Control Panel - Installer

Note: This section assumes that a wireless home network is 
installed and working correctly. In order for all supported features to 
work correctly, the network must also be connected to the Internet. 
It is important that the system’s Router is configured to DHCP.

Note: The N800 should already be connected to the network as 
described previously under Connectivity.
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To download VIA!TOOLS programming to the N800:

Select the N800’s Enable button under Download Timeout  

Press the Download Enable Button on the SS1

IR-LINK SENSE INPUTS

1 2 3

4 5 6

Download Enable
Button

SS1

Figure 4.40: SS1 Download Enable Button

In VIA!TOOLS, select the N800 to be programmed on the System Page. Go to 
the Transfer Page and select the Transfer to SS and/or VIA!2 button.

Figure 4.41: VIA!TOOLS Transfer Page

•

•

•
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The Transfer Page will pop up. Select Scan.

Figure 4.42: VIA!TOOLS Scan Page

The scanning process will display the SS1 and the N800 in the Transfer Page 
list. Ensure that the Transfer to Device checkbox is checked for both the N800 
and the SS1.

Figure 4.43: VIA!TOOLS Scan Page

Select Transfer to enable download to both the SS1 and N800. Once the progress 
bar has indicated that the download is complete, press Done.

•

•

•

•
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Customer Data:

Select the Customer Data button.

Figure 4.44: Customer Data

Enter relevent information using the on screen keyboard

Select OK.

Select Access Point
To select a network:

Press Set App AP.

Figure 4.45: Select Access Point

•

•

•

•



   © ELAN Home Systems  2007 • All rights reserved.                      Page 45

E L A N  H O M E  S Y S T E M S                  N800 4" Handheld Controller

Choose a pre- configured network from the drop- down menu.

Figure 4.46: Select Access Point

Press OK.

VIA!dj
To set a static IP address for a VIA!dj Digital Music Server:

Press Set ViaDj Address.

Touch the text box area with the stylus. The Virtual Keyboard will appear. Type the 
static IP address of the VIA!dj (available from the VIA!dj’s display), then press OK.

Figure 4.47: VIA!dj Static IP

•

•

•

•
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Update
To Update the N800’s software :

Press Update.

The unit will automatically connect to the Internet and download any available 
updates.

A verification screen will be displayed once the update is complete that will indi-
cate various information including software version, bug fixes and other useful infor-
mation.

Note: ELAN strongly recommends Updating the N800 before   
programming.

Figure 4.48: Update

Figure 4.49: Update Verification

•

•

•
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Web Browser
To open the browser:

Tap the Globe icon and select Open new browser window or Manage 
bookmarks as shown in Figure 4.49.

Figure 4.50: Web Browser

Open and Browse Web Pages
To open a web page:

Tap the Address field at the bottom of the screen, enter the address with the  
on- screen keyboard, and tap the Enter key (green arrow). 

Figure 4.51: Open a Web Page

•

•
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To reload a page:

Hold the stylus down briefly on the green arrow icon and select Reload. To stop 
loading the the page, tap the X icon.

To browse and scroll a web page:

Drag a page in the desired direction with the stylus, use the scroll keys, or drag the 
scroll bars on the right side and bottom of the screen.

To browse recently visited pages:

Tap the directional arrows on the bottom right browser bar.

To view a page in a larger or smaller size:

Press the + or - hard keys on the top left of the unit chassis. 

To select a predefined zoom level from the application menu, select Web > View> 
Zoom and the desired zoom level.

To view the web page in full screen size:

Press the Full Screen hard key on the top left of the unit chassis. To return to 
normal view, press the Full Screen hard key again.

To view the web page in optimized size:

Select Web > View > Optimized view. The web page is fit to the width of the 
screen; text and images are zoomed and scaled differently, if necessary.

To change the web browser settings:

Select Web > Tools > Settings. 

For more information, see the N800 help file.

Bookmarks
To add a bookmark to the current web page:

Hold the stylus down on the web page and select Add bookmark... from the 
context sensitive menu as shown in Figure 4.51.

To save a link as a bookmark:

Hold the stylus down on link and select Add link to bookmarks...as shown in 
Figure 4.51.

•

•

•

•

•

•

•

•

•

•
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Figure 4.52: Context Sensitive Menu

Manage Bookmarks
To manage bookmarks that have been saved in the N800: 

Tap the Globe icon and select Manage Bookmarks. In the Bookmark Manager, 
you can add, move, copy, rename, delete and open bookmarks and folders. 
The bookmark folders are shown on the left, and the bookmarks in the selected folder 
on the right. 

To open a folder and a bookmark contained in it:

Tap the folder, and tap the bookmark twice.

E-Mail
To send and receive e-mail messages you must have an active internet con-
nection and a registered e-mail account with the web browser provider such 
as Yahoo, MSN etc.

Cache
A cache is a memory location that is used to store data temporarily. If you 
have accessed confidential information requiring passwords, empty the 
cache after each use.

To empty the cache:

Select Web > Tools > Clear > Cache

•

•

•
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Battery Information
Charging and Discharging
Your device is powered by a rechargeable battery. The battery can be charged and discharged 
hundreds of times, but it will eventually wear out. When the operating and standby times are 
noticeably shorter than normal, replace the battery. Use only Nokia approved batteries, and 
recharge your battery only with Nokia approved chargers designated for this device.

If a replacement battery is being used for the first time or if the battery has not been used for a 
prolonged period, it may be necessary to connect the charger, then disconnect and reconnect it to 
begin charging the battery.

Unplug the charger from the electrical plug and the device when not in use. Do not leave a fully 
charged battery connected to a charger, since overcharging may shorten its lifetime. If left unused, 
a fully charged battery will lose its charge over time.

If the battery is completely discharged, it may take several minutes before the charging indicator 
appears on the display.

Use the battery only for its intended purpose. Never use any charger or battery that is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object such 
as a coin, clip, or pen causes direct connection of the positive (+) and negative (-) terminals of the 
battery. (These look like metal strips on the battery.) This might happen, for example, when you 
carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the bat-
tery or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, 
will reduce the capacity and lifetime of the battery. Always try to keep the battery between 15°C 
and 25°C (59°F and 77°F). A device with a hot or cold battery may not work temporarily, even
when the battery is fully charged. Battery performance is particularly limited in temperatures well 
below freezing.

Do not dispose of batteries in a fire as they may explode. Batteries may also explode if damaged. 
Dispose of batteries according to local regulations. Please recycle when possible. Do not dispose 
as household waste.

Do not dismantle or shred cells or batteries. In the event of a battery leak, do not allow the liquid to 
come in contact with the skin or eyes. In the event of such a leak, flush your skin or eyes immedi-
ately with water, or seek medical help.

Nokia Battery Authentication Guidelines

Always use original Nokia batteries for your safety. To check that you are getting an original Nokia 
battery, purchase it from an authorized Nokia dealer, look for the Nokia Original Enhancements logo 
on the packaging, and inspect the hologram label using the following steps:

Authenticate Hologram
  1.   When looking at the hologram
 on the label, you should see
 the Nokia connecting hands
 symbol from one angle and
t the Nokia Original
 Enhancements logo when
 looking from another angle.

  2.   When you angle the hologram
 left, right, down, and up, you
 should see 1, 2, 3, and 4 dots
 on each side respectively.

NOKIA

Hologram

BP-5L Battery
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  3.   Scratch the side of the label
 to reveal a 20-digit code,
 for example,
 12345678919876543210.
 Turn the battery so that the
 numbers are facing upwards.
 The 20-digit code reads
 starting from the number at
 the top row followed by the
 bottom row.

  4.   Confirm that the 20-digit
 code is valid by following
 the instructions at
 www.nokia.com/
 batterycheck.

Successful completion of the four steps is not a total assurance of the authenticity of the battery. 
If you have any reason to believe that your battery is not an authentic, original Nokia battery, you 
should refrain from using it, and take it to the nearest authorized Nokia service point or dealer for 
assistance. Your authorized Nokia service point or dealer will inspect the battery for authenticity.
If authenticity cannot be verified, return the battery to the place of purchase.

If you cannot confirm that your Nokia battery with the hologram on the label is an authentic Nokia 
battery, please do not use the battery. Take it to the nearest authorized Nokia service point or deal-
er for assistance. The use of a battery that is not approved by the manufacturer may be dangerous 
and may result in poor performance and damage to your device and its enhancements. It may also 
invalidate any approval or warranty applying to the device. To find out more about original Nokia 
batteries, visit www.nokia.com/battery.

Removal and Replacement
To remove battery for replacement:

Place thumb under the tab on the back of the unit and remove the rear panel.

Figure 4.53: Remove Rear Panel

•

NOKIA

Hologram

123456
123456

Scratch-Off
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Remove the battery from the right edge of the unit by prying up with thumbnail. 

Replace the battery as shown in Figure 4.53. Replace the rear panel.

Figure 4.54: Replace Battery

•

•
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5. Troubleshooting
Symptom Possible Cause Solution
N800 does not turn ON Battery discharged Recharge battery by con-

necting charger to charg-
ing port on N800

N800 battery does not 
charge

1. Wall charger plugged 
into outlet that has no AC 
voltage

Plug into confirmed live 
wall socket

2. Wall charger defective Replace charger

3. Battery defective Replace battery

Unable to download 
VIA!TOOLS program to 
N800 and/or SS1

1. Ethernet wiring to SS1 
is incorrect/disconnected/
defective

Verify and correct Ethernet 
wiring

2. SS1 not ready to con-
nect

Press DOWNLOAD 
ENABLE BUTTON on SS1

3. Incorrect VIA!TOOLS 
download procedure

carefully follow download 
steps in this manual and 
in VIA!TOOLS Help file

N800 won’t control devic-
es, zones, etc.

1. Router locked up Reset/Reboot Router
Reset/Reboot SS1

2. N800 and/or Router 
security settings incorrect-

Verify settings on N800 
and Router

3. System control wiring 
(IR/RS-232) incorrect

Verify and correct control 
wiring

4. Incorrect programming 
(wrong zone, missing IR/
RS-232 commands, incor-
rect sequences, etc.)

Verify and correct 
VIA!TOOLS programming

Cannot connect to the 
Internet

1. WAP issues Verify WAP communica-
tion 

2. Internet Service 
Provider issues

Verify internet connection 
from wired connection

3. Router/Modem issues Reset/Reboot Router and/
or modem

4. Firewall issues Check/verify firewall set-
tings - ensure firewall/
security settings will allow 
Internet connection for 
N800
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Appendix A: Specifications
Display
Display size 4.13”, 16X9 widescreen

Resolution High resolution 800X 480 pixels

Colors 65.5k

Web Browser
Audio ACC, AMR, MP2, MP3, RA (Real Audio) WAV, WMA

Image BMP, GIF, ICO, JPEG, PNG, TIFF, SVG-tiny

Video 3GP, AVI, H.263, MPEG-1, MPEG-4, RV (Real Video)

Memory/storage RAM 128MB, Flash 256MB

WLAN 802.11 b/g

Power 5 VDC 890 mA Wall Transformer Charger

Operating time Standby: 10 days; Operation: up to 3 hours continuous

Operating temp 14˚ to131˚ F, -10˚ to 55˚ C

Weight 7.27 oz./ 206g

Appendix B: Programming
All N800 Handheld Controllers must be programmed with ELAN VIA!®TOOLS 
Setup Software.

PC

Wireless
Touch Panel

N800
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Figure B.1: Programming

Please see the VIA!TOOLS Help file for complete step-by-step information on 
programming N800 Handheld Controllers.
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Appendix C: Wireless Networks
A properly functioning wireless network for the N800 consists of:

One or more N800s

An ELAN SS1 System Station

A Router

A Wireless Access Point (WAP)

The Router and WAP may be combined into a single device.

SS1 System Station
The SS1 System Station is an RS-232, IR, Sense and Relay controller. It also 
translates the N800’s 8.02.11b/g WiFi commands into actions that can con-
trol system functions including Home Theater or a zone control of an ELAN 
multi-room system. Future software/feature-set enhancements to the SS1  
are field-upgradeable through VIA!TOOLS setup software.

Note: For detailed connections and operation of the SS1, please con-
sult the SS1 Installation Manual.
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Figure C.1: SS1 System Station

Router
A router is a computer networking device that forwards data to its proper 
destination and connects two or more networks together. Routers typically 
connect home networks to the Internet. Wireless Routers that combine the 
functions of a Router and WAP are popular options for home networks.

Figure C.2: Router

•

•

•

•
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Wireless Access Point
The N800 requires a Wireless Access Point (WAP). The WAP is a device that 
connects the N800 together with the SS1 System Station to create a wireless 
control system. The WAP is connected directly to the router via ethernet, and 
relays data between the N800 and the SS1 System Station. Wireless Routers 
that combine the functions of a Router and WAP are popular options for 
home networks.

NOTE: 802.11b/g standards use the unlicensed 2.4 gigahertz (GHz) 
band. Operating in an unregulated frequency band, 802.11b and 
802.11g equipment can incur interference from microwave ovens, 
cordless phones, and other appliances using the same 2.4 GHz band.

Figure C.3: Wireless Access Point

Wireless Setup
It is essential that a functioning wireless network is set up and functioning 
prior to installing the N800. The Router needs to be configured for DHCP so 
that it provides IP addresses automatically for each component in the sys-
tem. In order to access the N800’s Internet Browser, the wireless network 
must be configured to access the Internet.

Detailed instructions on wireless network setup are outside the parameters of 
this manual. Please consult the documentation that accompanies the Router 
and/or WAP for specific instructions. 





P/N 9905961 REV:A

Limited Warranty
ELAN HOME SYSTEMS L.L.C. ("ELAN") warrants the N800 4" Handheld 
Controller to be free from defects in materials and workmanship for the period 
of one year (1 year) from date of purchase.  If within the applicable warranty 
period above purchaser discovers that such item was not as warranted above 
and promptly notifies ELAN in writing, ELAN shall repair or replace the item at 
the company's option.  This warranty shall not apply (a) to equipment not 
manufactured by ELAN, (b) to equipment which shall have been installed by 
other than an ELAN authorized installer, (c) to installed equipment which is not 
installed to ELAN's specifications, (d) to equipment which shall have been 
repaired or altered by others than ELAN, (e) to equipment which shall have 
been subjected to negligence, accident, or damage by circumstances beyond
ELAN's control, including, but not limited to, lightning, flood, electrical surge, 
tornado, earthquake, or other catastrophic events beyond ELAN's control, or 
to improper operation, maintenance or storage, or to other than normal use of 
service.  With respect to equipment sold by, but not manufactured by ELAN, 
the warranty obligations of ELAN shall in all respects conform to the warranty 
actually extended to ELAN by its supplier.  The foregoing warranties do not 
cover reimbursement for labor, transportation, removal, installation or other 
expenses which may be incurred in connection with repair or replacement.

Except as may be expressly provided and authorized in writing by ELAN, 
ELAN shall not be subject to any other obligations or liabilities whatsoever 
with respect to equipment manufactured by ELAN or services rendered by
ELAN.

THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL 
OTHER EXPRESSED AND IMPLIED WARRANTIES EXCEPT WARRANTIES 
OF TITLE, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

ATTENTION: TO OUR VALUED CONSUMERS

To ensure that consumers obtain quality pre-sale and after-sale support 

and service, ELAN Home Systems products are sold exclusively through 

authorized dealers.  ELAN products are not sold online.  The warranties 

on ELAN products are NOT VALID if the products have been purchased 

from an unauthorized dealer or an online E-tailer.  To determine if your 

ELAN reseller is authorized, please contact ELAN Home Systems at 

(859) 269-7760.

Lexington, KY

www.elanhomesystems.com

®




